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Chapter 1. Troubleshooting basics

To troubleshoot a problem, gather information about the problem for IBM® Software Support, use logging
data, and consult the lists of identified problems and workarounds.

For general troubleshooting information, see the IBM Tivoli Monitoring Troubleshooting Guide. For other
problem-solving options, see [Chapter 4, “Support information,” on page 37.

You can resolve some problems by ensuring that your system matches the system requirements. The most
up-to-date requirements are in the [Software product compatibility reports| (http://
publib.boulder.ibm.com/infocenter/prodguid /v1r0/clarity /index.html).

The following activities can help you find a solution to the problem you are having:

+ [“Gathering product information for IBM Software Support”|

* [“Using logging” on page 2|

+ [“Consulting the lists of identified problems and workarounds” on page 2|

Gathering product information for IBM Software Support

Before contacting IBM Software Support about a problem you are experiencing with this product, gather
the information shown in

Table 1. Information to gather before contacting IBM Software Support

Information type Description

Log files Collect trace log files from failing systems. Most logs are
located in a logs subdirectory on the host computer. See
[“Principal trace log files” on page 5| for lists of all trace
log files and their locations.

For general information about the IBM Tivoli®
Monitoring environment, see the Tivoli Enterprise Portal
User's Guide.

Sybase Server information Version number and patch level

Operating system Operating system version number and patch level
Messages Messages and other information displayed on the screen
Version numbers for IBM Tivoli Monitoring Version number of the following members of the

monitoring environment:

+ IBM Tivoli Monitoring. Also provide the patch level, if
available.

* Sybase ASE agent

Screen captures Screen captures of incorrect output, if any

(UNIX systems only) Core dump files If the system stops on UNIX systems, collect the core
dump file from the install_dir/bin directory, where
install_dir is the directory where you installed the
monitoring agent.

You can use the pdcollect tool to collect the most commonly used information from a system. This tool
gathers log files, configuration information, version information, and other data. For more information
about using this tool, see “pdcollect tool” in the IBM Tivoli Monitoring Troubleshooting Guide.

© Copyright IBM Corp. 2005, 2016 1
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For information about working with IBM Software Support, see [[BM Support Portal Service Requests and|
(http:/ /www.ibm.com/support/entry/portal/Open_service_request/Software/
Software_support_(general)).

Using logging

Logging is the primary troubleshooting feature in the monitoring agent. Logging refers to the text
messages and trace data that is generated by the agent. Messages and trace data are sent to a file.

Trace data captures transient information about the current operating environment when a component or
application fails to operate as designed. IBM Software Support personnel use the captured trace
information to determine the source of an error or unexpected condition. See [Chapter 2, “Trace logging,”|

for more information.

Consulting the lists of identified problems and workarounds

Known problems are organized into types such as those in the following list to make them easier to
locate:

* Installation, configuration, uninstallation
* Agent

* Tivoli Enterprise Portal

* Remote deployment

* Workspace

* Situation

* Sybase

See |Chapter 3, “Problems and workarounds,” on page 13| for information about symptoms and detailed
workarounds for these types of problems.

For general troubleshooting information, see the IBM Tivoli Monitoring Troubleshooting Guide.
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Chapter 2. Trace logging

Trace logs capture information about the operating environment when component software fails to
operate as intended. The principal log type is the RAS (Reliability, Availability, and Serviceability) trace
log. These logs are in the English language only. The RAS trace log mechanism is available for all
components of IBM Tivoli Monitoring. Most logs are located in a Togs subdirectory on the host computer.
See the following sections to learn how to configure and use trace logging:

» [“Principal trace log files” on page 5|

* [“Examples: using trace logs” on page 7|

* |“Enabling detailed tracing in the collector trace log” on page 7|

+ [“Setting RAS trace parameters” on page 9|

Note: The documentation refers to the RAS facility in IBM Tivoli Monitoring as "RAS1".

IBM Software Support uses the information captured by trace logging to trace a problem to its source or
to determine why an error occurred. The default configuration for trace logging, such as whether trace
logging is enabled or disabled and trace level, depends on the source of the trace logging. Trace logging
is always enabled.

Overview of log file management

[Table 2 on page 5| provides the names, locations, and descriptions of RAS1 log files. The log file names
adhere to the following naming convention:

hostname_product_adaptiveservername_program_timestamp-nn.log

where:

* hostname is the host name of the computer on which the monitoring component is running.

* product is the two-character product code. For Sybase agent, the product code is oy.

* adaptiveservername is the name of a database server instance that is being monitored.

* program is the name of the program being run.

* timestamp is an 8-character hexadecimal timestamp representing the time at which the program started.

* nn is a rolling log suffix. See [“Examples of trace logging”| for details of log rolling.

Examples of trace logging

For example, if a Sybase Server database "dbinst02" is running on computer "server01", the RAS log file
for the Sybase agent might be named as follows:

server0l_oy_dbinst02_koyagent_437fc59-01.10g

For long-running programs, the nn suffix is used to maintain a short history of log files for that startup of
the program. For example, the koyagent program might have a series of log files as follows:
server0l_oy_koyagent_437fc59-01.109

server0l oy koyagent 437fc59-02.10g
server0l_oy_koyagent_437fc59-03.109

As the program runs, the first log (n1=01) is preserved because it contains program startup information.
The remaining logs "roll." In other words, when the set of numbered logs reach a maximum size, the
remaining logs are overwritten in sequence. Each time a program is started, a new timestamp is assigned
to maintain a short program history. For example, if the Sybase agent is started twice, it might have log
files as follows:

© Copyright IBM Corp. 2005, 2016 3



server0l oy koyagent_ 437fc59-01.1og
server01_oy_koyagent_437fc59-02.10g
server0l oy koyagent 437fc59-03.10g

server0l oy koyagent 537fc59-01.1og
server0l_oy_ koyagent_537fc59-02.10g
server0l_oy koyagent 537fc59-03.10g

Each program that is started has its own log file. For example, the Sybase agent would have agent logs in
this format:

server0l oy koyagent 437fc59-01.1og

Other logs, such as logs for collector processes and Take Action commands, have a similar syntax, as in
the following example:

server0l oy koysql 447fc59-01.7og
where koyesql is the name of a program.

Note: When you communicate with IBM Software Support, you must capture and send the RAS1 log
that matches any problem occurrence that you report.
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Principal trace log files

contains locations, file names, and descriptions of trace logs that can help determine the source of
problems with agents.

Table 2. Trace log files for troubleshooting agents

System where log
is located

File name and path

Description

On the computer
that hosts the
monitoring agent

See |I Definitions oﬂ

|variables| for
descriptions of the
variables in the
file names in
column two.

Traces activity of the monitoring agent.

Note: Other logs, such as logs for collector processes
and Take Action commands (if available), have a
similar syntax and are located in this directory path.

On Windows: The collector trace log file is named
hostname_oy_adaptiveservername_col.out. The file is
located in the install_dir\tmaitm6\logs path.

On UNIX: The collector trace log file is named
hostname_oy_adaptiveservername_col.log and is
located in the install_dir/logs path.

Note: A hostname_oy adaptiveservername_col.out log
file also exists and contains stderr and stdout
messages.

A collector trace log file is produced
by the Sybase agent. New log files are
created each time the agent is started.
The log file is not pruned. One backup
copy is renamed from the following
file, and kept for historical purposes:

* On Windows: *.out to *.oul

* On UNIX: *log to *.lol

See [“Enabling detailed tracing in the|
[collector trace log” on page 7 for
information about how to change the
default behavior of this type of

logging.

On Windows: The "agt" trace log file is named
hostname_QOY _adaptiveservername_agt.out. The file is
located in the install_dir\tmaitm6\logs path.

On UNIX: The "agt" trace log file is named
hostname_oy_adaptiveservername_agt.log and is

located in the install_dir/logs path. See

Traces activity of the monitoring agent.

* On Windows: New log files are
created each time the agent is
started. One backup copy, renamed
from *.out to *.oul, is kept for
historical purposes. The log file is
not pruned.

* On UNIX: New log files are created
each time the agent is started. One
backup copy, renamed from *.log to
*lg1 is kept for historical purposes.

The *SYB.LGO file is located in the following path:
* On Windows: install_dir\tmaitmé\logs
* On UNIX: install _dir/logs

A new version of this file is generated

every time the agent is restarted. IBM

Tivoli Monitoring generates one

backup copy of the *SYB.LGO file with

the tag .LGl. View *SYB.LGO to learn

the following details regarding the

current monitoring session:

* Status of connectivity with the
monitoring server

* Situations that were running,
including historical data collection
situations

* Success or failure status of Take
Action commands

Chapter 2. Trace logging 5



Table 2. Trace log files for troubleshooting agents (continued)

System where log

Monitoring Server

See |Deﬁnitions oﬂ
|Xariables| for

descriptions of the
variables in the
file names in
column two.

install_dir/1ogs path.

On Windows: The file in the install _dir\InstallITM
path. Unlike RASI log files, the name of the file
displays a decimal time stamp. *

is located File name and path Description
On the Tivoli Provides details about products that
Enterprise On UNIX: The candle_installation.log file in the are installed.

Note: Trace logging is enabled by
default. A configuration step is not
required to enable this tracing.

The Warehouse _Configuration.log file is located in the
following path on Windows: install_dir\Install1ITM.

Provides details about the
configuration of data warehousing for
historical reporting.

The RASI log file is named hostname_ms_timestamp-
nn.log and is located in the following path:

* On Windows: install_dir\logs
* On UNIX: install dir/logs

Note: File names for RASI logs include a hexadecimal
time stamp

Also on UNIX, a log with a decimal time stamp is
provided: hostname_ms_timestamp.log and
hostname_ms_timestamp.pidnnnnn in the
install_dir/logs path, where nnnnn is the process ID
number.

Traces activity on the monitoring
server.

On the Tivoli
Enterprise Portal
Server

See |Definitions oﬂ
|x_/ariables| for

descriptions of the
variables in the
file names in
column two.

The RASI log file is named hostname_cq_timestamp-
nn.log and is located in the following path:

* On Windows: install_dir\logs
* On UNIX: install_dir/logs

Note: File names for RASI logs include a hexadecimal
time stamp

Also on UNIX, a log with a decimal time stamp is
provided: hostname_cq_timestamp.log and
hostname_cq_timestamp.pidnnnnn in the install_dir/logs
path, where nnnnn is the process ID number.

Traces activity on the portal server.

The TEPS_ODBC. 1og file is located in the following path
on Windows: install_dir\InstallITM.

When you enable historical reporting,
this log file traces the status of the
warehouse proxy agent.

Definitions of variables for RASI logs:

* hostname is the host name of the computer on which the agent is running.
* install_dir represents the directory path where you installed the IBM Tivoli Monitoring component. install_dir can
represent a path on the computer that hosts the monitoring server, the monitoring agent, or the portal server.

* product is the two-character product code. For Sybase agent, the product code is oy.

* adaptiveservername refers to the name of the database server instance that you are monitoring.

* program is the name of the program being run.
* timestamp is an eight-character hexadecimal time stamp representing the time at which the program started.
* nn is a rolling log suffix. See [“Examples of trace logging” on page 3| for details of log rolling.

See the IBM Tivoli Monitoring Installation and Setup Guide for more information on the complete set of
trace logs that are maintained on the monitoring server.
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Examples: using trace logs

Typically IBM Software Support applies specialized knowledge to analyze trace logs to determine the
source of problems. However, you can open trace logs in a text editor to learn some basic facts about
your IBM Tivoli Monitoring environment.

Example one
This excerpt shows the typical .LGO log for a failed connection between a monitoring agent and a
monitoring server with the host name serverla:
(Thursday, August 11, 2005, 08:21:30-{94C}kdc10c1.c,105,"KDCLO_ClientLookup") status=1c020006,
"Tocation server unavailable", ncs/KDC1 _STC_SERVER _UNAVAILABLE
(Thursday, August 11, 2005, 08:21:35-{94C}kraarreg.cpp,1157,"LookupProxy") Unable to connect to
broker at ip.pipe:: status=0, "success", ncs/KDC1_STC_OK
(Thursday, August 11, 2005, 08:21:35-{94C}kraarreg.cpp,1402,"FindProxyUsinglLocallLookup") Unable
to find running CMS on CT_CMSLIST <IP.PIPE:#serverla>

Example two
The following excerpts from the trace log for the monitoring server show the status of an agent,

identified here as "Remote node." The name of the computer where the agent is running is
SERVERS5B:

(42C039F9.0000-6A4: kpxreghb.cpp, 649, "HeartbeatInserter") Remote node SERVER5B:KOY is ON-LINE.

(42C3079B.0000-6A4: kpxreghb.cpp,644,"HeartbeatInserter") Remote node SERVER5B:KOY is OFF-LINE.

Key points regarding the preceding excerpt:

* The monitoring server appends the KOY product code to the server name to form a unique
name (SERVER5B:KO0Y) for this instance of Sybase agent. This unique name enables you to
distinguish multiple monitoring products that might be running on SERVER5B.

* The log shows when the agent started (ON-LINE) and later stopped (OFF-LINE) in the
environment.

* For the sake of brevity an ellipsis (...) represents the series of trace log entries that were
generated while the agent was running.

* Between the ON-LINE and OFF-LINE log entries, the agent was communicating with the
monitoring server.

¢ The ON-LINE and OFF-LINE log entries are always available in the trace log. All trace levels
that are described in [“Setting RAS trace parameters” on page 9| provide these entries.

On Windows, you can use the following alternate method to view trace logs:

1. In the Windows Start menu, choose Program Files > IBM Tivoli Monitoring > Manage Tivoli
Monitoring Service. The Manage Tivoli Enterprise Monitoring Services window is displayed.

2. Right-click a component and select Advanced > View Trace Log in the pop-up menu. The program
displays the Select Log File window that lists the RAS1 logs for the monitoring agent.

3. Select a log file from the list and click OK. You can also use this viewer to access remote logs.

Note: The viewer converts time stamps in the logs to a readable format.

Enabling detailed tracing in the collector trace log

Collector trace logs are generated by a database monitoring agent. You can use the following options to
modify collector trace logging.

Option one: modify the settings file
About this task

Perform the following steps to enable detailed logging for the collector trace log:

Chapter 2. Trace logging 7



Procedure

1. Open the koytrac.ctl file. The file is located in the following path:
* On Windows: install _dir\tmaitmé
* On UNIX systems: install_dir/misc

Where install_dir is the location of the IBM Tivoli Monitoring component.
2. Remove the two semicolons (;;) from the beginning of the line that contains trace_all;.
Save the file.

4. Restart the monitoring agent for the database server instance that you want to trace. Logging goes to
a collector trace log file that is named in [Table 2 on page 5 The log file is stored in the following path:

w

* On Windows: install _dir\tmaitmé\logs
* On UNIX systems: install_dir/logs

Where install_dir is the path where you installed IBM Tivoli Monitoring.

5. When you complete an analysis of detailed trace logs, turn off detailed logging as follows, because
trace logs can consume a large amount hard disk space.

a. Open the koytrac.ct1 file mentioned in Step 1.
b. Type two semicolons (;;) at the beginning of the line that contains trace_all;.
c. Save the file.

d. Restart the monitoring agent for the database server instance that you have been tracing.

Option two: modify the environment variables
About this task

You can modify trace logging for the collector log by setting the following environment variables:

COLL_WRAPLINES
By default, new collector log files are created each time you start the agent or when the log file
reaches the limit specified by the COLL_WRAPLINES environment variable.
COLL_WRAPLINES defines the number of lines in the col.out file and is 30,000 lines by default
(about 2 MB).

COLL_NUMOUTBAK
By default, the product creates one backup copy of the collector log file. The file tag is changed
from *.out to *.oul. You can configure the product to create up to nine backup files by defining
COLL_NUMOUTBAK to be an integer from one to nine.

Set the environment variables as follows:

* On UNIX: Use a text editor to enter a new integer value for the variables in the
hostname_oy_adaptiveservername_name.cfg file in the install_dir/config directory. (If you want your
changes to affect all monitoring agents that are running on the computer, modify the oy.ini file.) Save
your changes and restart the agent.

¢ On Windows:

1. In the Windows Start menu, choose Program Files > IBM Tivoli Monitoring > Manage Tivoli
Monitoring Service. The Manage Tivoli Enterprise Monitoring Services window is displayed.

2. Right-click the row that contains the name of the monitoring agent whose environment variables
you want to set.

3. Select Advanced > Edit Variables in the pop-up menu.

4. If the agent is running, accept the prompt to stop the agent. A restart is necessary so that the
environment variable that you create takes effect.

5. The list dialog is displayed. When only the default settings are in effect, there are no variables
displayed. The variables are listed after you override them.
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6. Override the variable settings as follows:
a. Click Add.

b. Select the variable you want to modify in the Variable pull-down menu. For example, select
COLL_NUMOUTBAK.

c. Type a value in the Value field. For example, type the number 9, the maximum number of
backup files that can be generated.

d. Select OK two times.
e. Restart the agent.

Setting RAS trace parameters

Objective

Pinpoint a problem by setting detailed tracing of individual components of the monitoring agent and
modules.

Background Information

Sybase agent uses RAS1 tracing and generates the logs described in [Table 2 on page 5| The default RAS1
trace level is ERROR.

RASI tracing has control parameters to manage to the size and number of RAS1 logs. Use the procedure
described in this section to set the parameters.

Note: The KBB_RAS1_LOG parameter also provides for the specification of the log file directory, log file
name, and the inventory control file directory and name. Do not modify these values or log information
can be lost.

Before you begin

See [“Overview of log file management” on page 3| to ensure that you understand log rolling and can
reference the correct log files when you are managing log file generation.

After you finish

Monitor the size of the logs directory. Default behavior can generate a total of 45 to 60 MB for each agent
that is running on a computer. For example, each database server instance that you monitor could
generate 45 to 60 MB of log data. See the "Procedure" section to learn how to adjust file size and numbers
of log files to prevent logging activity from occupying too much disk space.

Regularly prune log files other than the RAS1 log files in the logs directory. Unlike the RAS1 log files
which are pruned automatically, other log types can grow indefinitely, for example, the logs in [Table 2 o

that include a process ID number (PID).

Consider using collector trace logs (described in [Table 2 on page 5) as an additional source of
troubleshooting information.

Note: The KDC_DEBUG setting and the Maximum error tracing setting can generate a large amount of
trace logging. Use them only temporarily, while you are troubleshooting problems. Otherwise, the logs
can occupy excessive amounts of hard disk space.

Procedure
About this task

Specify RASI trace options in the install_dir\tmaitm6\KOYENV file on Windows or the
install_dir/config/oy.ini file on UNIX systems.
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Note: On UNIX, the trace options that you set in the oy.ini file apply to all database server instances
that you are monitoring on the computer where oy.ini is located. An additional trace options file,
hostname_oy adaptiveservername.cfg, exists for each database server instance. The
hostname_oy_adaptiveservername.cfg file inherits its settings from the oy.ini file. If you want to set trace
options for a specific instance only, modify options in the hostname_oy_adaptiveservername.cfg file.

Use one of the following methods to modify trace options:

* Manually edit the configuration file to set trace logging
1. Open the trace options file:
— On Windows, open the install_dir\tmaitm6\KOYENV file.
— On UNIX systems, open the /install_dir/config/oy.ini file.
2. Edit the line that begins with KBB_RAS1= to set trace logging preferences.
For example, if you want detailed trace logging, set the Maximum Tracing option:
— On Windows,
KBB_RAS1=ERROR (UNIT:kdd ALL) (UNIT:koy ALL) (UNIT:kra ALL)
— On UNIX systems,
export KBB_RAS1='ERROR (UNIT:kdd ALL) (UNIT:koy ALL) (UNIT:kra ALL)'
3. Edit the line that begins with KBB_RAS1_LOG= to manage the generation of log files:
— Edit the following parameters to adjust the number of rolling log files and their size.

- MAXEFILES: the total number of files that are to be kept for all startups of a given program.
Once this value is exceeded, the oldest log files are discarded. Default value is 9.

- LIMIT: the maximum size, in megabytes (MB) of a RASI log file. Default value is 5.
— IBM Software Support might guide you to modify the following parameters:

- COUNT: the number of log files to keep in the rolling cycle of one program startup. Default
value is 3.

- PRESERVE: the number of files that are not to be reused in the rolling cycle of one program
startup. Default value is 1.

Note: The KBB_RAS1_LOG parameter also provides for the specification of the log file directory,
log file name, and the inventory control file directory and name. Do not modify these values or log
information can be lost.

4. Restart the monitoring agent so that your changes take effect.
* (Windows only) Alternate method to edit trace logging parameters:
1. Open the Manage Tivoli Enterprise Monitoring Services window.
2. Right-click the icon of the monitoring agent whose logging you want to modify.

3. Select Advanced > Edit Trace Parms. The Tivoli Enterprise Monitoring Server Trace Parameters
window is displayed.
4. Select a new trace setting in the pull-down menu in the Enter RAS1 Filters field or type a valid
string.
The selections are as follows:
— No error tracing. KBB_RAS1=-none-
— General error tracing. KBB_RAS1=ERROR
— Intensive error tracing. KBB_RAS1=ERROR (UNIT:koy ALL)
— Maximum error tracing. KBB_RAS1=ERROR (UNIT:koy ALL) (UNIT:kra ALL)

Note: As this example shows, you can set multiple RAS tracing options in a single statement.

5. Modify the value for "Maximum Log Size Per File (MB)" to change the log file size (changes LIMIT
value).

6. Modify the value for "Maximum Number of Log Files Per Session" to change the number of logs
files per startup of a program (changes COUNT value).
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7. Modify the value for "Maximum Number of Log Files Total" to change the number of logs files for
all startups of a program (changes MAXFILES value).

8. (Optional) Click Y (Yes) in the KDC_DEBUG Setting menu to log information that can help you
diagnose communications and connectivity problems between the monitoring agent and the
monitoring server.

Note: The KDC_DEBUG setting and the Maximum error tracing setting can generate a large
amount of trace logging. Use them only temporarily, while you are troubleshooting problems.
Otherwise, the logs can occupy excessive amounts of hard disk space.

9. Click OK. You see a message reporting a restart of the monitoring agent so that your changes take
effect.
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Chapter 3. Problems and workarounds

The following sections provide symptoms and workarounds for problems that might occur with Sybase
agent:

+ [“Installation and configuration troubleshooting”|

* |“Agent troubleshooting” on page 23|

» [“Tivoli Enterprise Portal troubleshooting” on page 28|

* [“Workspace troubleshooting” on page 30|

+ [“Remote Deployment troubleshooting” on page 29|

» [“Situation troubleshooting” on page 32|

[‘Sybase troubleshooting” on page 35|

Note: You can resolve some problems by ensuring that your system matches the system requirements
listed in the Prerequisites topic in the Information Center or the [Software product compatibility reports|
(http:/ /publib.boulder.ibm.com/infocenter /prodguid /v1r0/clarity /index.html). Search for the ITCAM for
Applications product.

This chapter provides agent-specific troubleshooting information. See the IBM Tivoli Monitoring
Troubleshooting Guide for general troubleshooting information.

Installation and configuration troubleshooting

This section provides tables that show solutions for the following types of installation, configuration, and
uninstallation problems:

* Operating system problems

* Problems with database applications

Table 3. Problems and solutions for installation and configuration for agents that run on UNIX systems

Problem Solution

When you upgrade to IBM Tivoli Fix packs for Candle, Version 350, are delivered as each monitoring agent is
Monitoring, you might need to apply |upgraded to IBM Tivoli Monitoring.

fix packs to Candle, Version 350, Note: The IBM Tivoli Monitoring download image or CD provides

agents. application fix packs for the monitoring agents that are installed from that

CD (for example, the agents for operating systems such as Windows,
Linux, UNIX, and i5/0S). The upgrade software for other agents is located
on the download image or CDs for that specific monitoring agent, such as
the agents for database applications.

If you do not upgrade the monitoring agent to IBM Tivoli Monitoring, the
agent continues to work. However, you must upgrade to have all the
functionality that IBM Tivoli Monitoring offers.

Presentation files and customized The upgrade from version 350 to IBM Tivoli Monitoring handles export of
OMEGAMONP® DE screens for Candle |the presentation files and the customized OMEGAMON DE screens.
monitoring agents need to be
upgraded to a new Linux on z/Series
system.

The following message is displayed in |There is no workaround. The previous value of KBB_RAS1 from the

the installation log for some Windows |OMEGAMON V350 agent is used, preserving prior customer settings for
agents when upgrading from Tivoli this variable. The problem has no adverse effect on the installation or
OMEGAMON V350: <REPLACELINE> subsequent operation of the monitoring agent .

Pair missing 1=[KBB_RAS1=ERROR] no
2, skipped.
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Table 3. Problems and solutions for installation and configuration for agents that run on UNIX systems (continued)

Problem

Solution

Non-ASCII characters entered into the
configuration window for the
monitoring agent do not show up or
are not the correct characters.

Enter only ASCII characters into these fields.

During the command-line installation,
you choose to install a component that
is already installed, and you see the
following warning:

WARNING - you are about to install
the SAME version of "component"

where component is the name of the
component that you are attempting to
install.

Note: This problem affects UNIX
command-line installations. If you
monitor only Windows environments,
you would see this problem if you
choose to install a product component
(for example, a monitoring server) on
UNIX.

You must exit and restart the installation process. You cannot return to the
list where you selected components to install. When you run the installer
again, do not attempt to install any component that is already installed.

While installing the agent from a CD
or DVD, the following message is
displayed and you are not able to
continue the installation:

install.sh warning: unarchive of

"/cdrom/unix/filename.tar" may
have failed

This error is caused by low disk space. Although the install.sh script
indicates that it is ready to install the agent software, the script considers
the size of all tar files, not the size of all the files that are contained within
the tar file.Run the df -k command to check whether the file systems have
enough space to install agents.

Cannot locate the KDCBO_HOSTNAME
setting.

Go to install_dir/config and edit the corresponding .ini file. Set the
KDCBO_HOSTNAME parameter followed by the IP address. If you use multiple
network interface cards (NICs), give the Primary IP address of the network
interface.

The Sybase agent repeatedly restarts.

You can collect data to analyze this problem as follows:

1. Access the install dir/config/oy.ini file, which is described in
[“Setting RAS trace parameters” on page 9.|

2. Add the following line: KBB_SIGl=trace —dumpoff

Agents in the monitoring environment
use different communication protocols.
For example, some agents have
security enabled and others do not.

Configure both the monitoring server and the Warehouse proxy server to
accept multiple protocols, as described in the IBM Tivoli Monitoring
Installation and Setup Guide.

Creating a firewall partition file: The
partition file enables an agent to
connect to the monitoring server
through a firewall.

How it works: When the agents start, they search KDCPARTITION.TXT for
the following matches:

* An entry that matches the partition name OUTSIDE.
* An entry that also includes a valid external address.

For more information, see the IBM Tivoli Monitoring Installation and Setup
Guide.

The monitoring agent does not start in
a non-ASCII environment.

Check the agent configuration to ensure that all the values are correctly
represented. To view these parameters, go to the Manage Tivoli Enterprise
Monitoring Services window, select the agent template, and choose the
Configure using defaults. From the resulting window, select and edit the
database instance to view its parameters.
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Table 3. Problems and solutions for installation and configuration for agents that run on UNIX systems (continued)

Problem

Solution

Text for configuration functions is
displayed in English instead of native
languages when installing and
configuring the monitoring agent. For
example, when using the itmemd
config command on a UNIX or Linux
system.

None. You must complete configuration of the monitoring agent using
English.

On UNIX and Linux systems during
configuration with the
CandleDBConfig or itmemd config —A
commands, the Sybase agent does not
correctly identify the instance name
and configuration status.

For example, if 'uname -n' returns
test_system_raleigh, and the instance
name is test_inst, and it is fully
configured, the search will indicate
that the instance name is raleigh and it
is not configured.

The instance can be configured and will run correctly. This is only a
problem with displaying an inventory of servers on this particular screen.
There is no workaround for correcting the display.

The Sybase agent configuration on UNIX and Linux does not correctly
identify the instance name and configuration status if either the hostname
(as returned by uname -n) or the instance name contains any of the
following characters:

. (period)

: (colon)

= (equals)

" (double quote)

When configuring the monitoring agent, you might see the following
information if any of the special characters listed above exist in the
hostname.

Select one of the following:

1. Confine automatic search to running databases
2. Also search for non-running databases (slower)
3. No automatic search. Manual update only.

4. Tutorial on automatic search techniques and limitations

Function menu
Select an option or <CR> to exit: 1
Performing initial scan for Oracle. Please wait...
Scanning servers currently running or in /etc/oratab

Inventory of known Oracle servers before search: X=Excluded
I=Incomplete raleigh(I)

Inventory of known Oracle servers after search: X=Excluded
I=Incomplete raleigh(I)

You successfully upgraded from an
OMEGAMON monitoring agent to
IBM Tivoli Monitoring, Version 6.2.0.
However, when you configure
historical data collection, you see an
error message that includes, Attribute
name may be invalid, or attribute
file not installed for warehouse
agent.

Copy the attribute files (koy.atr) for the upgraded monitoring agent to
install_dir\tmaitmé\attrlib on the computer where you have installed
the Warehouse Proxy agent. The Warehouse Proxy agent must be able to
access the short attribute names for tables and columns. That way, if the
longer versions of these names exceed the limits of the Warehouse
database, the shorter names can be substituted.

Chapter 3. Problems and workarounds
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Table 4. Problems and solutions for installation and configuration for agents that run on Windows systems

Problem

Solution

When you upgrade to IBM Tivoli
Monitoring, you might need to
apply fix packs to Candle, Version
350, agents.

Fix packs for Candle, Version 350, are delivered as each monitoring agent is
upgraded to IBM Tivoli Monitoring.

Note: The IBM Tivoli Monitoring download image or CD provides application
fix packs for the monitoring agents that are installed from that CD (for example,
the agents for operating systems such as Windows, Linux, UNIX, and i5/0S).
The upgrade software for other agents is located on the download image or CDs
for that specific monitoring agent, such as the agents for database applications.

If you do not upgrade the monitoring agent to IBM Tivoli Monitoring, the agent
continues to work. However, you must upgrade to have all the functionality that
IBM Tivoli Monitoring offers.

Presentation files and customized
OMEGAMON DE screens for
Candle monitoring agents need to
be upgraded to a new Linux on
z/Series system.

The upgrade from version 350 to IBM Tivoli Monitoring handles export of the
presentation files and the customized OMEGAMON DE screens.

Diagnosing problems with
product browse settings.

When you have problems with browse settings, perform the following steps:

1. Click on Start > Programs > IBM Tivoli Monitoring > Manage Tivoli
Enterprise Monitoring Services. The Manage Tivoli Enterprise Monitoring
Services is displayed.

2. Right-click the Windows agent and select Browse Settings. A text window is
displayed.

3. Click Save As and save the information in the text file. If requested, you can
forward this file to IBM Software Support for analysis.

A message similar to "Unable to
find running CMS on
CT_CMSLIST" in the log file is
displayed.

If a message similar to "Unable to find running CMS on CT_CMSLIST" is

displayed in the Log file, the agent is not able to connect to the monitoring

server. Confirm the following points:

* Do multiple network interface cards (NICs) exist on the system?

* If multiple NICs exist on the system, find out which one is configured for the
monitoring server. Ensure that you specify the correct host name and port
settings for communication in the IBM Tivoli Monitoring environment.

The monitoring agent does not
start in a non-ASCII environment.

Check the agent configuration to ensure that all the values are correctly
represented. To view these parameters, go to the Manage Tivoli Enterprise
Monitoring Services window, select the agent template, and choose the
Configure using defaults. From the resulting window, select and edit the
database instance to view its parameters.

Text for configuration functions is
displayed in English instead of
native languages when installing
and configuring the monitoring
agent. For example, when using
the Manage Tivoli Enterprise
Monitoring Services GUI on a
Windows system.

None. You must complete configuration of the monitoring agent using English.

You successfully upgraded from
an OMEGAMON monitoring
agent to IBM Tivoli Monitoring,
Version 6.2.0. However, when you
configure historical data
collection, you see an error
message that includes, Attribute
name may be invalid, or
attribute file not installed
for warehouse agent

Copy the attribute files (koy.atr) for the upgraded monitoring agent to
install_dir\tmaitm6\attrlib on the computer where you have installed the
Warehouse Proxy agent. The Warehouse Proxy agent must be able to access the
short attribute names for tables and columns. That way, if the longer versions of
these names exceed the limits of the Warehouse database, the shorter names can
be substituted.
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Table 4. Problems and solutions for installation and configuration for agents that run on Windows

systems (continued)

Problem Solution

Registry entries are not removed |Manually delete the registry entries from the following path before you install
when the agent is installed on a | the agent:

64-bit Windows system. HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Cand1e\KOY\610\

Table 5. Problems and solutions for installation and configuration of the Sybase agent

Problem

Solution

The procedure for launching the
Sybase agent: Trace Parameters
window ir{“Setting RAS trace|
|parameters" on page 9| fails.

This problem happens when the trace options are missing from the
configuration file. You can correct the problem as follows:

1. Edit a configuration file with the following path name:
* On Windows systems: install_dir\tmaitm6\KOYENV
* On UNIX and Linux systems: /install_dir/config/oy.ini
2. Paste the following configuration setting in the file:
* On Windows:
KBB_RAS1=ERROR "> C:\IBM\ITM\tmaitm6\10gs\KOYRAS1.LOG
¢ On UNIX and Linux systems:
export KBB RAS1='ERROR'

Note: If you installed the product in a directory path other than the
default, use that directory path instead.

1. Save your changes.

2. Repeat the |“Setting RAS trace parameters” on page 9| procedure. Now
the Tivoli Enterprise Monitoring Server: Trace Parameters window is
displayed.

Collector trace logs are not receiving
error information.

Review the information in |Chapter 2, “Trace logging,” on page 3| to ensure
that you are consulting the correct log file. The file is located in the
following path: install_dir\tmaitm6, where install_dir is the location of
IBM Tivoli Monitoring.

After running the agent successfully,
you reinstall the agent software, and
collection of monitoring data stops.

Consult the list of supported versions in the configuration chapter of the
agent user's guide for Sybase. Confirm that you are running a valid version
of the target application. If you are monitoring a supported version of the
database application, gather log files and other information and contact
IBM Software Support, as described in [“Gathering product information for|
[[BM Software Support” on page 1|

Alert summary report of Tivoli
Enterprise Portal shows no
information.

Ensure that the COLL_ERRORLOG setting defines a valid path. Confirm
that the error log file is correct. If the error log file is correct, the problem
can occur because the logon account that you are using does not have
sufficient permissions in the IBM Tivoli Monitoring environment.

Error counts are displayed in the Alert
summary report in the Tivoli
Enterprise Portal, however, error
messages are not displayed in the
Alert detail report.

Check the time stamp for the reports. If you have set up historical data
collection for Alert summary report, it is recommended that you set up
historical data collection for the Alert detail report, too.
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Table 5. Problems and solutions for installation and configuration of the Sybase agent (continued)

Problem

Solution

Problems with database connectivity
occur because the KOYGRANT script
is not run.

Specifically, you might see an error like the following in the collector trace
log:
* In Sybase: The Sybase agent displays the following message:

YEMO155E (193633) Failed to open SYBASE Server connection \
YCDO130E (193633)
Unable to connect to SYBASE server:HDCHASDSTC0041,
id:tivoli, Retcode= 0

* In Oracle: The Oracle agent displays -942 error in the collector log file as
shown in this excerpt:

RPFO340T (5/19/05) Time = 2005/05/19 15:07:40 For cursor KSS5, \
rows collected for insert =1

RPFO300T (5/19/05) Doing prep_1_fet for cursor KSS6

RSCO2001 (5/19/05) SQLCODE for PREPARE = -942

RSCO205T (5/19/05) Stmt = SELECT max(bytes)
v§log

RSC0220W (5/19/05) ORACLE Message ORA-00942: table or view does \
not exist for PREPARE

CGN1521E (5/19/05) Interval collection failed for cursor KORSRVR

MAXLOGBYTE FROM \

After installation, run the koygrant.sql script to obtain a connection ID, as
described in the Installation and Configuration Guide for the agent.

To collect data, the agent must have the DBA select privilege on the Sybase
system tables.

After the agent starts the 'kddos
isremote failed, no localization'
message is displayed.

When the tmp directory path is inaccessible two things happen:
* The logs are stored in the install_dir/logs directory

* The message kddos isremote failed, no localization is displayed as
shown in this excerpt:

$ ./CandleAgent start oy

CandleAgent installer level 350 / 547.
CandleAgent : considering servers: name.
kddexec: kddos isremote failed, no localization
Collector and Agent started for name

You can safely ignore this message.

You see the following error message
when you execute itmemd config.

Your kddos root permission is not
set. This will impede database
self-discovery. Please exit and
have the superuser issue the
following commands:

cd /ct99rle/sTee/AIX5

chown root */bin/kddos

chmod u+sx */bin/kddos
Press enter to continue, or type
"exit" to exit.

The full text of this message is
provided in the next row.

Run the itmemd config -A oy command under install_dir/bin directory
to configure the monitoring agent. It calls the kddfind.sh script internally.
The kddfind.sh script is located under install_dir/0S_dir/bin directory.
The kddfind.sh script uses kddos and kddos64 internally. If you have not
set root permissions or setuid, you get this error message whenever
itmemd config starts. You must change the owner and setuid of kddos
(and kddos64) before executing itmemd config -A oy, as in this example:
$su -root

# cd install_dir/$0Ssubdir/bin

# chown root kddos

# chmod u+sx kddos

On HP-UX and SunOS, you have to make the same settings for kddosé4, as
in this example:

# chown root kddos64
# chmod u+sx kddos64
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Table 5. Problems and solutions for installation and configuration of the Sybase agent (continued)

Problem Solution

Sample itmemd config -A oy error message:

$ ./itmemd config -A oy
Candle DB config: Welcome to CandleDBconfig 07/07/05 8:46

CandleDBconfig prepares the environment to run the OMEGAMON Monitoring Agent
(OMA) for distributed databases. CandleDBconfig:

1. Prepares a configuration file for each monitored server, so that the OMA
knows how to talk to the database.

2. Verifies that the installation is correct and operational.

CandleDBconfig finds running databases much more easily and reliably than
non-running databases. If you want to monitor databases that are not currently
running, you might wish to exit CandleDBConfig and start them.

Also, CandleDBconfig works best if you have more than 25 display lines. Both
X-Windows and NT Telnet allow you to expand the number of Tines without
disconnecting from UNIX. You don't have to issue any UNIX commands to take
advantage of the increased lines.

Your kddos root permission is not set. This will impede database self-
discovery. Please exit and have the super-user issue the following commands:

cd /ct99rle/slee/AIX5
chown root */bin/kddos
chmod u+sx */bin/kddos
Press enter to continue, or type "exit" to exit.

Unique names for monitoring IBM Tivoli Monitoring might not be able to generate a unique name for
components: ORIGINNODE is monitoring components due to the truncation of names that the product
truncated and doesn't show the automatically generates. IBM Tivoli Monitoring automatically creates a
product code. name for each monitoring component by concatenating the subsystem

name, host name, and product code separated by colons
(subsystem_name:hostname:OY).

Note: When you monitor a multinode systems, like databases, IBM Tivoli
Monitoring uses a database instance name as the subsystem name.

The length of the name that IBM Tivoli Monitoring generates is limited to
32 characters. Truncation can result in multiple components having the
same 32-character name. If this problem happens, shorten the
subsystem_name portion of the name as described in the steps in the
following rows:

Chapter 3. Problems and workarounds
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Table 5. Problems and solutions for installation and configuration of the Sybase agent (continued)

Problem Solution

* On Windows:
Note: This procedure involves editing the Windows Registry. An error in editing the Registry may cause other
system errors. It is best practice to make a backup copy of the Registry prior to modifying the Registry. If you do
not feel comfortable editing the Registry, contact IBM Software Support.

1.
2.

Run the Registry editor, regedit. Select Start > Run. Type regedit in the field and click OK.
Locate the following key:
HKEY_LOCAL_MACHINE\SOFTWARE\Cand1e\KOY\610\instance_name

where instance_name is the Sybase Server instance name that is associated with the target agent.
Open the Environment key.

Select the CTIRA_SUBSYSTEM_ID string attribute. If you do not find CTIRA_SUBSYSTEM_ID, add it. step
6. Type a new name for an instance name ( subsystem name) For the step 4 -6, if user can't find
CTIRA_SUBSYSTEM_ID, add it.

Right-click and select Modify.

Type a new instance name (subsystem name). Keep in mind that the final concatenated name, including the
subsystem name, host name, and OY, cannot be longer than 32 characters.

Note: You must ensure that the resulting name is unique with respect to any existing monitoring component
that was previously registered with the Tivoli Enterprise Monitoring Server.

Exit from the Registry editor.

Restart the agent.

A second instance in the Tivoli Enterprise Portal Navigation tree might be automatically added. If this
happens, clear the old, offline agent instance navigation item using the Managed System Status workspace of
the Enterprise Navigation tree item.

* On UNIX:

1.

4.
5.

Open the configuration file for the monitoring agent, which is located in the following path:

install_dir / config/hostname_oy_instancename.cfg

Find the line the begins with CTIRA_SUBSYSTEM_ID=.

Type a new name for instance name (subsystem_name) that is a unique, shorter name for the instance name
(subsystem_name). The final concatenated name including the subsystem name, new host name, and OY, cannot
be longer than 32 characters.

Note: You must ensure that the resulting name is unique with respect to any existing monitoring component
that was previously registered with the Tivoli Enterprise Monitoring Server.

Save the file.
Restart the agent.

If you cannot find the CTIRA_SUBSYSTEM_ID environment variable, you must add it to the configuration file
of the monitoring agent. Open hostname_oy_instancename.cfg and add CTIRA_SUBSYSTEM_ID with the new instance
name.
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Table 5. Problems and solutions for installation and configuration of the Sybase agent (continued)

Problem

Solution

Bad data is displayed in the Tivoli
Enterprise Portal.

A long IBM Tivoli Monitoring installation directory name on a Windows
system on which a Sybase agent is running causes bad data to appear in
the Tivoli Enterprise Portal when the IBM Tivoli Monitoring installation
directory contains directory names that are longer than 8 characters. This
problem is caused by improper handling of the "~" (tilde) character that
Windows inserts into directory names longer than 8 characters when
creating an 8 character directory alias.

Edit the Windows registry for each agent instance on the system where the
monitoring agent is running.

For a 32-bit Windows environment, change the data associated with the
COLL_HOME value in the HKEY_LOCAL_MACHINE\Software\Candle\
KOY\610\sybase instance\Environment key to the full directory name so
the COLL_HOME data contains no "~" (tilde) character. Restart the
monitoring agent after making the change.

For a 64-bit Windows environment, change the data associated with the
COLL_HOME value in the HKEY_LOCAL_MACHINE\SOFTWARE\
Wow6432Node\Candle\KOY\610\sybase instance\Environment key to the
full directory name so the COLL_HOME data contains no "~" (tilde)
character. Restart the Sybase monitoring after making the change.

Note: Reconfiguring an agent instance resets the registry key. These
modifications must be reapplied.

For the Sybase agent, the Start, Stop,
and Advanced Configuration functions
do not work from the GUL

Install the xterm program, which is available from RedHat.

If you specify the full path for the
Database Server Open Client while
configuring the agent, the agent fails
to connect to the Sybase ASE server.

Configure the monitoring agent by specifying the short path for the
Database Server Open Client. The SYBASE_OCS parameter provides the
path for the Database Server Open client.

To specify the short path as the value for the SYBASE_OCS parameter,
complete the following steps:

1. Open the configuration file of the monitoring agent, which is located in
the following path:

install_dir/config/hostname_oy_instancename.cfg

2. For the SYBASE_OCS parameter, specify the short path for the Database
Server Open Client.

3. Save the file, and restart the agent.

When the Sybase Server attempts to
connect to the database, the following
error message is generated due to a
short wait timeout period:

The server encountered an error
connecting to database <db_name>
CIR1880E(021426)0pen Probe pipe
errno= 2.Pipe=/opt/Tivoli/ITM/tmp/
sdcO1lpsyb09.

keybank.com oy_LPKSYPD1/
prb_LPKSYPD1 koy sdcOlpsyb09.
keybank.com_07020147_7161 pipe.
Cursor=K0YPRCS

Increase the timeout period of the Sybase Server by completing the
following steps:

1. Open the configuration file for the monitoring agent, which is located in
the following path:

install_dir/config/hostname_oy instancename.cfg
2. Specify these values of the following parameters:

¢ COLL_WAIT_TIMEOUT=600

* WAIT_TIMEOUT=600
3. Save the file, and restart the agent.
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Table 5. Problems and solutions for installation and configuration of the Sybase agent (continued)

Problem Solution
The prerequisite checker that is Run the prerequisite checker manually by using the following commands:
integrated with the Sybase agent + On Windows systems: install_dir\Sybase_Agent_Installer\WINDOWS\
installer fails to run. prereqchecker\prereq_checker.bat KOY
* On UNIX and Linux systems: install_dir/Sybase_Agent_Installer/
unix/prereqchecker/prereq_checker.sh KOY

Table 6. General problems and solutions for uninstallation

Problem Solution

On Windows, uninstallation of Confirm that the following problems do not exist:

IBM Tivoli Mom.tormg faﬂs to * Ensure that you are the only user who is logging into the computer where
uninstall the entire environment. you are performing an uninstallation operation. If another user is performing

operations during an uninstall process, the uninstall process fails.

* Be sure that you follow the general uninstallation process described in the
IBM Tivoli Monitoring Installation and Setup Guide:

1. Uninstall monitoring agents first, as in the following examples:
— Uninstall a single monitoring agent for a specific database.
—OR—
— Uninstall all instances of a monitoring product, such as IBM Tivoli
Monitoring for Databases.

2. Uninstall IBM Tivoli Monitoring.

The way to remove inactive Use the following steps to remove, but not uninstall, an offline managed system
managed systems (systems whose |from the Navigator tree:

status is OFFLINE) from the 1. Click the Enterprise icon in the Navigator tree.

Navigator tree in the portal is not

. 2. Right-click, then click Workspace > Managed System Status.
obvious.

3. Right-click the offline managed system, and select Clear offline entry.

If you also want to uninstall the monitoring agent, use the procedure described
in the IBM Tivoli Monitoring Installation and Setup Guide.

Unique names for monitoring components

IBM Tivoli Monitoring might not be able to generate a unique name for monitoring components because
of the truncation of names that the product automatically generates.

IBM Tivoli Monitoring automatically creates a name for each monitoring component by concatenating the
subsystem name, host name, and product code separated by colons (subsystem_name:hostname:OY).

Note: When you monitor a multinode system, such as a database, IBM Tivoli Monitoring adds a
subsystem name to the concatenated name, typically a database instance name.
The length of the name that IBM Tivoli Monitoring generates is limited to 32 characters. Truncation can
result in multiple components having the same 32-character name. If this problem happens, shorten the
hostname portion of the name as follows:
1. Open the configuration file for the monitoring agent, which is located in the following path:

* On Windows: install_dir\tmaitm6\KOYCMA_instance.ini.

¢ On UNIX and Linux: install _dir/config/oy.ini.
2. Find the line that begins with CTIRA_HOSTNAME-=.

3. Type a new name for host name that is a unique, shorter name for the host computer. The final
concatenated name including the subsystem name, new host name, and OY, cannot be longer than 32
characters.
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Note: You must ensure that the resulting name is unique with respect to any existing monitoring
component that was previously registered with the Tivoli Enterprise Monitoring Server.

4. Save the file.
Restart the agent.

o

6. If you do not find the files mentioned in Step 1, perform the workarounds listed in the next

paragraph.

If you do not find the files mentioned in the preceding steps, uninstall the monitoring agent, then

reinstall.

Agent troubleshooting

This section lists problems that might occur with agents.

This chapter provides agent-specific troubleshooting information. See the IBM Tivoli Monitoring
Troubleshooting Guide for general troubleshooting information.

Table 7. General agent problems and solutions

Problem

Solution

When you edit the configuration
for an existing monitoring agent,
the values displayed are not
correct.

The original configuration settings might include non-ASCII characters. These
values were stored incorrectly and result in the incorrect display. Enter new
values using only ASCII characters.

A problem can arise when you
run multiple agents on one
computer and want them to
communicate with multiple
monitoring servers, as described
in this example:

* Agents are running on
computer and communicating
with a Tivoli Enterprise
Monitoring Server, called
TEMSI.

* You install a new agent on the
same computer and you want
this agent to communicate with
a different monitoring server,
called TEMS2.

* When you configure the new
agent to communicate with
TEMS?2, all the existing agents
are re-configured to
communicate with TEMS2.

You must reconfigure the previously existing agents to restore their
communication connection with TEMS1. For example, you can right-click the
row for a specific agent in the Manage Tivoli Enterprise Monitoring Services,
and select Reconfigure. See the IBM Tivoli Monitoring Installation and Setup Guide
for more information about reconfiguration.

The system experiences high CPU
usage after you install or
configure Sybase agent.

View the memory usage of the KOYCMA process. If CPU usage seems to be
excessive, recycle the monitoring agent.
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Table 7. General agent problems and solutions (continued)

Problem

Solution

The Sybase data collector does
not return data and appears to
stop.

When using isql you might see a
message such as the following;:
Space available in the log
segment has fallen critically
low in the tempdb database.
A11 future modifications to
this database will be
suspended until the log is
successfully dumped and space
becomes available. The
transaction log in database
tempdb is almost full. Your
transaction is being suspended
until space is made available
in the log.

These are indications that the tempdb database is full. Custom databases do not
experience this problem.

Any database that encounters this problem needs to have the following option

defined:
sp_dboption tempdb, "abort tran on log full", true

You can use isql to define that option for a database. This example uses tempdb
as the database where the option is being set. You must set this option on each
individual database that is having the problem.
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Table 7. General agent problems and solutions (continued)

Problem

Solution

A configured and running
instance of the monitoring agent
is not displayed in the Tivoli
Enterprise Portal, but other
instances of the monitoring agent
on the same system do appear in
the portal.

Tivoli Monitoring products use Remote Procedure Call (RPC) to define and
control product behavior. RPC is the mechanism that allows a client process to
make a subroutine call (such as GetTimeOfDay or ShutdownServer) to a server
process somewhere in the network. Tivoli processes can be configured to use
TCP/UDP, TCP/IP, SNA, and SSL as the desired protocol (or delivery
mechanism) for RPCs.

"IP.PIPE" is the name given to Tivoli TCP/IP protocol for RPCs. The RPCs are
socket-based operations that use TCP/IP ports to form socket addresses. IP.PIPE
implements virtual sockets and multiplexes all virtual socket traffic across a
single physical TCP/IP port (visible from the netstat command).

A Tivoli process derives the physical port for IPPIPE communications based on
the configured, well-known port for the HUB Tivoli Enterprise Monitoring
Server. (This well-known port or BASE_PORT is configured using the 'PORT:'
keyword on the KDC_FAMILIES / KDE_TRANSPORT environment variable
and defaults to '1918'".)

The physical port allocation method is defined as (BASE_PORT + 4096*N) where
N=0 for a Tivoli Enterprise Monitoring Server process and N={1, 2, ..., 15} for a
non-Tivoli Enterprise Monitoring Server. Two architectural limits result as a
consequence of the physical port allocation method:

* No more than one Tivoli Enterprise Monitoring Server reporting to a specific
Tivoli Enterprise Monitoring Server HUB can be active on a system image.

* No more that 15 IP.PIPE processes can be active on a single system image.

A single system image can support any number of Tivoli Enterprise Monitoring
Server processes (address spaces) provided that each Tivoli Enterprise
Monitoring Server on that image reports to a different HUB. By definition, there
is one Tivoli Enterprise Monitoring Server HUB per monitoring Enterprise, so
this architecture limit has been simplified to one Tivoli Enterprise Monitoring
Server per system image.

No more that 15 IP.PIPE processes or address spaces can be active on a single
system image. With the first limit expressed above, this second limitation refers
specifically to Tivoli Enterprise Monitoring Agent processes: no more that 15
agents per system image.

This limitation can be circumvented (at current maintenance levels, IBM Tivoli
Monitoring V6.1 Fix Pack 4 and later) if the Tivoli Enterprise Monitoring Agent
process is configured to use EPHEMERAL IP.PIPE. (This is IP.PIPE configured
with the 'EPHEMERAL:Y' keyword in the KDC_FAMILIES / KDE_TRANSPORT
environment variable). There is no limitation to the number of ephemeral
IPPIPE connections per system image. If ephemeral endpoints are used, the
Warehouse Proxy Agent is accessible from the Tivoli Enterprise Monitoring
Server associated with the agents using ephemeral connections either by running
the Warehouse Proxy Agent on the same computer or by using the Firewall
Gateway feature. (The Firewall Gateway feature relays the Warehouse Proxy
Agent connection from the Tivoli Enterprise Monitoring Server computer to the
Warehouse Proxy Agent computer if the Warehouse Proxy Agent cannot coexist
on the same computer.)

Attributes do not allow
non-ASCII input in the Situation
Editor.

None. Any attribute that does not include "(Unicode)" might support only ASCII
characters. For example "Attribute (Unicode)" will support unicode but
"Attribute” without "(Unicode)" might only support ASCII characters.
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Table 7. General agent problems and solutions (continued)

Problem

Solution

Tivoli Enterprise Console events
from IBM Tivoli Monitoring V6.2
for IBM Tivoli Monitoring v5.x
migrated situations have parsing
errors in the TEC server.

1. Ensure that you have IBM Tivoli Monitoring V6.2 Event Synchronization
installed on your Tivoli Enterprise Console® server.

2. Obtain updated baroc files from the Sybase agent events. Updated baroc files
are in TEMS in install_dir/CMS/TECLIB/itm5migr. There are updated files
for koy.baroc, DataCacheRM_IXB.baroc, LocksRM_IXB.baroc,
SpaceUsageRM_IXB.baroc, StateRM_IXB.baroc, SybaseAvailability_IXB.baroc,
Threshold.baroc, TrafficRM_IXB.baroc, WaitsRM_IXB.baroc, and
SybaseMon_tbsm_notification.baroc.

You are receiving Tivoli Business
Service Manager events that
cannot be associated because
application_oid and
application_class are not set.

This problem is caused by IBM Tivoli Monitoring V6.2 sending TEC events for
IBM Tivoli Monitoring 5.x migrated situations. These events are not able to set
the cited slot values. Replace the SybaseMon_IXB_tbsmfwd_itm.sh script on the
Tivoli Enterprise Console server with the version of this file from the TEMS in

install_dir/CMS/TECLIB/itm5migr.

Table 8. Agent problems and solutions on the UNIX operating system

Problem

Solution

You see an unknown instance of
the monitoring agent for Sybase
called koyagent in the Tivoli
Enterprise Portal.

The verification process for the Sybase agent creates a Sybase server instance
called koyagent. The system creates this instance to validate the connection to the
Tivoli Enterprise Monitoring Server. The Tivoli Enterprise Portal shows an entry
for this Sybase server instance, even though that instance only exists during the
verification steps. To remove this instance from Tivoli Enterprise Portal, follow
the standard process for removing an instance on the Tivoli Enterprise Portal.
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Table 8. Agent problems and solutions on the UNIX operating system (continued)

Problem Solution

Agent unable to connect: The This error message means that the agent is not able to connect to the computer

agent is started, but no reports | where the Tivoli Enterprise Monitoring Server is running. The reason might be

are displayed on Tivoli any one of the following:

Enterprise Monitoring Server. Computer where the Tivoli Enterprise Monitoring Server is running is down

The log file includes the Ping the computer where the Tivoli Enterprise Monitoring Server is

following error: running and make sure that it is up and running.

Unable to find running CMS on |Tivoli Enterprise Monitoring Server is not running

CMSLIST or Endpoint If the Tivoli Enterprise Monitoring Server is not running, recycle the

unavailable Tivoli Enterprise Monitoring Server and verify whether the agent is
connecting.

Multiple NIC Cards on the computer where the Tivoli Enterprise Monitoring
Server is running,.
If multiple NICs are installed on the computer where the Tivoli
Enterprise Monitoring Server is running, identify the Primary NIC and
use the hostname or IP address.

Verify that the Tivoli Enterprise Monitoring Server has been configured
with the Primary NIC's IP address or hostname.

If you are using hostname, make sure that /etc/hosts has a valid entry
for the Primary NICs host name and its IP address.

On the Tivoli Enterprise Monitoring Server set the KDCBO_HOSTNAME
variable to the primary IP address of the computer. Use the same
address to configure the agent.

To connect to the Tivoli Enterprise Monitoring Server, configure the
agent with Primary NIC's IP address or host name of the computer
where the Tivoli Enterprise Monitoring Server is running.

While configuring the agent, make sure that the port number that you
are connecting to is correct. If you are not using the default port
number, make sure that you are using the same port number used in
Tivoli Enterprise Monitoring Server.For more information, see the IBM
Tivoli Monitoring Installation and Setup Guide.

Agent is behind the Firewall
If you use a Firewall, identify whether you have any one of the
following scenarios:
* Hub monitoring server INSIDE, and agents OUTSIDE
* Hub and remote monitoring servers INSIDE, agents OUTSIDE
* Hub monitoring server INSIDE, remote monitoring server and agents

OUTSIDE

See |Creating a firewall partition file| for information about the
KDC_PARTITION file that enables communication across a firewall. For
additional information, see the IBM Tivoli Monitoring Installation and
Setup Guide.

Connecting to the monitoring server through a Virtual Private Network (VPN)
In some cases, the agent or a remote monitoring server needs to connect
to the hub monitoring server through a VPN. You must configure the
communication channel (pipe) to be ephemeral, as in the following
example:

KDC_FAMILIES=ip.pipe port:port_number
ephemeral:y ip use:n sna use:n
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Table 8. Agent problems and solutions on the UNIX operating system (continued)

Problem

Solution

The values for the following
attributes are zero when the
Sybase agent is running in a
Solaris 10 non-global zone:
Total OS CPU Percent (Sybase
Server Summary attribute
group)

Server CPU Percent (Sybase
Server Summary attribute
group)

Server CPU Pct System
(Sybase Process Summary
attribute group)

Server CPU Percent
Application (Sybase Process
Summary attribute group)
Current® CPU Pct Used
(Sybase Process Detail
attribute group)

These attributes cannot be collected unless resources that provide CPU
information are shared with the non-global zone. When the resources are shared,
the monitoring agent has visibility to certain CPU characteristics that are
required to determine the value of these attributes.

If the Sybase agent is running in a non-global zone, which is necessary when the
Sybase Server product is running in a non-global zone, then the global zone
resources must be shared with the non-global zone. If this is not feasible for your
environment, then these values are zero. Do not trigger situations based on the
above values. In the Tivoli Enterprise Portal and in the warehouse, these
attributes are zero.

and running normally. After
rebooting the computer where
the Tivoli Enterprise Monitoring

the system that hosts the Tivoli
agent is not online or some
when you use CandleAgent

start, the agent starts and
continues running.

The monitoring agent is installed

Server was running, or restarting
Enterprise Monitoring Server, the

workspaces are empty. However,

This problem can occur when the agent is installed locally using a non-root user,
or when the agent is installed remotely using the Run As option on the GUI or
using the _UNIX_STARTUP_.Username option on the tacmd addSystem command
line.

Verify whether you have used a non-root user to install the monitoring agent.
Manually start the monitoring agent using the correct user ID.

For more information, see “Agent upgrade and restart using non-root” in the
Installation and Configuration Guide for the Sybase agent.

Tivoli Enterprise Portal troubleshooting

lists problems that might occur with the Tivoli Enterprise Portal. This chapter provides
agent-specific troubleshooting information. See the IBM Tivoli Monitoring Troubleshooting Guide for general

troubleshooting information.

Table 9. Tivoli Enterprise Portal problems and solutions

Problem

Solution

Historical data collection is
unavailable because of
incorrect queries in the Tivoli
Enterprise Portal.

The column, Sort By, Group By, and First/Last functions are not compatible with
the historical data collection feature. Use of these advanced functions will make a
query ineligible for historical data collection.

Even if data collection has been started, you cannot use the time span feature if the
query for the chart or table includes any column functions or advanced query
options (Sort By, Group By, First / Last).

To ensure support of historical data collection, do not use the Sort By, Group By, or
First/Last functions in your queries.

See the IBM Tivoli Monitoring Administrator’s Guide the Tivoli Enterprise Portal
online Help for information on the Historical Data Collection function.
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Table 9. Tivoli Enterprise Portal problems and solutions (continued)

Problem

Solution

When you use a long process
name in the situation, the
process name is truncated.

Truncation of process names in the portal display is the expected behavior. 64 bytes
is the maximum name length.

Collector inactive is
displayed in Sybase agent
workspaces.

Collector Inactive usually means that the data collector is not running. The data
collector is not passing data to the monitoring agent, which in turn is not passing
data to the Tivoli Enterprise Monitoring Server, so the Tivoli Enterprise Portal has
no data to display.

Check to see if the agt.out log file is full of open pipe messages.
1. Stop the Sybase agent.

2. Define COLL_USESHM in the hostname_oy_sybase servername.cfg file in the
install_dir / config directory.

3. Export COLL_USESHM=1
4. Restart the Sybase agent.

If you ran "Verify OMA
installation" during the
configuration of the Sybase
agent on a UNIX system, an
entry labeled koragent is
displayed in the Navigator
tree for that system on the
Tivoli Enterprise Portal
desktop. When the Sybase
agent is started following
configuration, the correct entry
for the Oracle system is
displayed in the Navigator
tree, and the koragent entry
remains. Eventually, the
koragent entry turns gray, but
it never disappears.

When koragent turns gray, use the following steps to remove it from the system:
1. Click the Enterprise Navigator item.
2. Right-click and select Workspace -> Managed System Status.

w

In the Managed System Status table, click the entry that starts with “koragent.”
4. Right-click koragent, and select Clear offline entry.

Remote Deployment troubleshooting

able 10| lists problems that might occur with remote deployment. This section provides information
about troubleshooting remote deployment of the monitoring agent. See the IBM Tivoli Monitoring
Troubleshooting Guide for general troubleshooting information.

This section describes problems and solutions for remote deployment and removal of agent software

Agent Remote Deploy:

Table 10. Remote deployment problems and solutions

Problem

Solution

While you are using the remote deployment feature
to install Sybase agent, an empty command window
is displayed on the target computer. This problem
occurs when the target of remote deployment is a
Windows computer. (See the IBM Tivoli Monitoring
Installation and Setup Guide for more information on
the remote deployment feature.)

Do not close or modify this window. It is part of the
installation process and will be dismissed automatically.
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Table 10. Remote deployment problems and solutions (continued)

Problem Solution

This problem might happen when you attempt the remote
The removal of a monitoring agent fails when you | removal process immediately after you have restarted the
use the remote removal process in the Tivoli Tivoli Enterprise Monitoring Server. You must allow time for
Enterprise Portal desktop or browser. the monitoring agent to refresh its connection with the Tivoli
Enterprise Monitoring Server before you begin the remote
removal process.

Workspace troubleshooting

able 11{ shows problems that might occur with workspaces. This chapter provides agent-specific
troubleshooting information. See the IBM Tivoli Monitoring Troubleshooting Guide for general
troubleshooting information.

Table 11. Workspace problems and solutions

Problem Solution

The name of the attribute does not display ina | When a chart or graph view that includes the attribute is scaled
bar chart or graph view. to a small size, a blank space is displayed instead of a truncated
name. To see the name of the attribute, expand the view of the
chart until there is sufficient space to display all characters of the
attribute's name.

You start collection of historical data but the data | Managing options for historical data collection:

cannot be seen. * Basic historical data collection populates the Warehouse with
raw data. This type of data collection is turned off by default.
For information about managing this feature, including how to
set the interval at which data is collected, see the Installation
and Configuration Guide for the agent. By setting a more
frequent interval for data collection you reduce the load on the
system incurred every time data is uploaded.

* You use the Summarization and Pruning monitoring agent to
collect specific amounts and types of historical data. Be aware
that historical data is not displayed until the Summarization
and Pruning monitoring agent begins collecting the data. By
default, this agent begins collection at 2 AM daily. At that
point, data is visible in the workspace view. See the IBM Tivoli
Monitoring Administrator's Guide to learn how to modify the
default collection settings.
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Table 11. Workspace problems and solutions (continued)

Problem

Solution

When support for the Sybase agent is installed
on the Tivoli Enterprise Portal Server, you see the
following error when you export workspaces
using the tacmd exportworkspaces command:

KUICEWO13E The exportWorkspaces command
failed and could not successfully export all
workspaces. Please consult the
C:\IBM\ITM\1ogs\
WorkspaceImportExportCLI_0.1og Tog file to
determine the cause of the error.

The Sybase agent supports the exporting of workspaces except
for the following summarized performance workspaces:

* Sybase Historical Summarized Performance

* Sybase Historical Summarized Performance Weekly

* Sybase Historical Summarized Performance Daily

* Sybase Historical Summarized Performance Hourly

You can export all workspaces for the Sybase agent except these

four, or export all workspaces except those for this monitoring
agent.

For information about exporting workspaces other than the four
workspaces that do not support export on the Tivoli Enterprise
Portal Server, see “Exporting workspaces” in the Reference guide
for the Sybase agent.

See the IBM Tivoli Monitoring User’s Guide for information about
exporting all workspaces on the Tivoli Enterprise Portal Server
except all of the workspaces for a specific monitoring agent.

Data is not displayed for the Database Detail
attribute group due to lock conflicts with the
SP_SPACEUSED stored procedure.

The Sybase agent provides the COLL_USE_ITM_SPACEUSED
configuration item, which uses a user-defined stored procedure
to avoid lock conflicts.

To avoid lock conflicts, complete the following steps:

1. Contact the Sybase administrator to create the
SP_ITM_SPACEUSED stored procedure, that is a duplicate of
the SP_SPACEUSED system stored procedure, with isolation
level as 0.

Attention: If a unique index error is displayed for the
master.dbo.spt_values table while creating the stored
procedure, run the following command to create a unique
index on the table: Create unique index uni_index on
master.dbo.spt_values(name, number, type)

2. Complete one of the following steps:

* On UNIX and Linux systems, append the following line to
the install_dir/config/oy.config and
install_dir/config/oy.ini files:
export COLL_USE_ITM_SPACEUSED=1

* On Windows systems, append the following line to Local
Settings section of the install_dir\TMAITM6\koycma.ini
file:

COLL_USE_ITM_SPACEUSED=1
3. Restart the agent.

The agent now uses the user-defined stored procedure to fetch
data for the Database Detail attribute group.
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Table 11. Workspace problems and solutions (continued)

Problem Solution

In some environments, the agent takes a long The Sybase agent provides the

time to fetch data for the Segment Detail COLL_USE_ITM_HELPSEGMENT configuration item, which
workspace. uses a self-defined stored procedure to fetch data for the

Segment Detail workspace. To configure the agent to use the
user-defined stored procedure for fetching data, complete the
following steps:

1. Contact the Sybase administrator to create the
SP_ITM_SEGSPACE and the SP_ITM_SEGSPACE_ALL_DBS
stored procedures in the Sybase ASE server. These stored
procedures are a duplicate of the SP_SEGSPACE and
SP_SEGSPACE_ALL_DBS system stored procedures.

2. Complete one of the following steps:

* On UNIX and Linux systems, append the following line to
the install_dir/config/oy.config and
install_dir/config/oy.ini files:
export COLL_USE_ITM_HELPSEGMENT=1

* On Windows systems, append the following line to Local
Settings section of the install_dir\TMAITM6\koycma.ini
file:

COLL_USE_ITM_HELPSEGMENT=1
3. Restart the agent.

Situation troubleshooting

This section provides information about both general situation problems and problems with the
configuration of situations. See the IBM Tivoli Monitoring Troubleshooting Guide for more information about
troubleshooting for situations.

General situation problems
lists problems that might occur with specific situations.

Table 12. Specific situation problems and solutions

Problem Solution

You want to change the appearance of |1 Right-click an item in the Navigation tree.
situations when they are displayed in a

. 2. Select Situations in the pop-up menu. The Situation Editor window is
Workspace view.

displayed.
3. Select the situation that you want to modify.

4. Use the Status pull-down menu in the lower right of the window to
set the status and appearance of the Situation when it triggers.
Note: This status setting is not related to severity settings in IBM
Tivoli Enterprise Console.

Monitoring activity requires too much Check the RAS trace logging settings that are described in
disk space. [trace parameters” on page 9. For example, trace logs grow rapidly when
you apply the ALL logging option.

A formula that uses mathematical This formula is incorrect because situation predicates support only logical
operators appears to be incorrect. For operators. Your formulas cannot have mathematical operators.

example, if you were monitoring Sybase |Note: The Situation Editor provides alternatives to math operators.
Server, a formula that calculates when | Regarding the example, you can select % Processes Bad attribute and
Total Processes Bad falls under 10 avoid the need for math operators.

percent of Total Processes does not
work: LT #'KOYPRCS.NUMPROCESS' / 10
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Table 12. Specific situation problems and solutions (continued)

Problem

Solution

If you are running a version of the
Sybase agent before V6.2 and you
choose to alter the views to include a
new attribute, data for this attribute is
not displayed and you see a blank
column in this view.

To enable Unicode and other features, upgrade the monitoring agent to
IBM Tivoli Monitoring, Version 6.2.0.

You see the 'Unable to get attribute
name' error in the Tivoli Enterprise
Monitoring Server log after creating a
situation.

Ensure that the agent attribute files are installed on the Tivoli Enterprise
Monitoring Server.

The following example shows a typical log entry when you have this

problem:

(4320916A.0049-F60:kfaottev.c,1572,"TransTate_ResultBuffer") \
Unable to get attribute name for tablename/column \
<UAG524400.UA4>. Ignored.

Situations are triggered in the Tivoli
Enterprise Monitoring Server, but events
for the situation are not sent to the
Tivoli Enterprise Console server. The
Tivoli Enterprise Monitoring Server is
properly configured for event
forwarding, and events for many other
situations are sent to the event server.

None. This is a limitation of the Tivoli Enterprise Monitoring Server event
forwarding function. Situations that only monitor other situations do not
send events to the event server.

This condition can occur when a situation is only monitoring the status of
other situations. The event forwarding function requires an attribute
group reference in the situation in order to determine the correct event
class to use in the event. When the situation only monitors other

situations, no attribute groups are defined and the event class cannot be
determined. Because the event class cannot be determined, no event is
sent.

Problems with configuration of situations
lists problems that might occur with situations.

This section provides information for troubleshooting for agents. Be sure to consult the IBM Tivoli
Monitoring Troubleshooting Guide for more general troubleshooting information.

Table 13. Problems with configuring situations that you solve in the Situation Editor

Problem

Solution

2. C(lick Edit > Situation Editor.

Note: To get started with the solutions in this section, perform these steps:
1. Launch the Tivoli Enterprise Portal.

3. In the tree view, choose the agent whose situation you want to modify.
4. Choose the situation in the list. The Situation Editor view is displayed.

The situation for a specific agent is
not visible in the Tivoli Enterprise
Portal.

Open the Situation Editor. Access the All managed servers view. If the situation
is absent, confirm that application support for Sybase agent has been added to
the monitoring server. If not, add application support to the server, as
described in the IBM Tivoli Monitoring Installation and Setup Guide.

The monitoring interval is too
long.

Access the Situation Editor view for the situation that you want to modify.
Check the Sampling interval area in the Formula tab. Adjust the time interval
as needed.

The situation did not activate at
startup.

Manually recycle the situation as follows:
1. Right-click the situation and choose Stop Situation.
2. Right-click the situation and choose Start Situation.

Note: You can permanently avoid this problem by placing a check mark in the
Run at Startup option of the Situation Editor view for a specific situation.
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Table 13. Problems with configuring situations that you solve in the Situation Editor (continued)

Problem

Solution

The situation is not displayed.

Click the Action tab and check whether the situation has an automated
corrective action. This action can occur directly or through a policy. The
situation might be resolving so quickly that you do not see the event or the
update in the graphical user interface.

An Alert event has not occurred
even though the predicate has been
properly specified.

Check the logs, reports, and workspaces.

A situation fires on an unexpected
managed object.

Confirm that you have distributed and started the situation on the correct
managed system.

The product did not distribute the
situation to a managed system.

Click the Distribution tab and check the distribution settings for the situation.

The situation does not fire.

Incorrect predicates are present in
the formula that defines the
situation. For example, the
managed object shows a state that
normally triggers a monitoring
event, but the situation is not true
because the wrong attribute is
specified in the formula.

In the Formula tab, analyze predicates as follows:

1. Click the fx icon in the upper-right corner of the Formula area. The Show
formula window is displayed.

a. Confirm the following details in the Formula area at the top of the
window:
* The attributes that you intend to monitor are specified in the formula.
* The situations that you intend to monitor are specified in the formula.
* The logical operators in the formula match your monitoring goal.
* The numerical values in the formula match your monitoring goal.

b. (Optional) Click the Show detailed formula check box in the lower left
of the window to see the original names of attributes in the application
or operating system that you are monitoring.

c. Click OK to dismiss the Show formula window.

2. (Optional) In the Formula area of the Formula tab, temporarily assign
numerical values that will immediately trigger a monitoring event. The
triggering of the event confirms that other predicates in the formula are
valid.

Note: After you complete this test, you must restore the numerical values
to valid levels so that you do not generate excessive monitoring data based
on your temporary settings.

Table 14. Problems with configuration of situations that you solve in the Workspace area

Problem

Solution

Situation events are not displayed
in the Events Console view of the
workspace.

Associate the situation with a workspace.
Note: The situation does not need to be displayed in the workspace. It is
sufficient that the situation be associated with any workspace.

You do not have access to a
situation.

Note: You must have administrator privileges to perform these steps.
1. Select Edit > Administer Users to access the Administer Users window.
2. In the Users area, select the user whose privileges you want to modify.

3. In the Permissions tab, Applications tab, and Navigator Views tab, select
the permissions or privileges that correspond to the user's role.

4. Click OK.

A managed system seems to be
offline.

1. Select Physical View and highlight the Enterprise Level of the navigator
tree.

2. Select View > Workspace > Managed System Status to see a list of
managed systems and their status.

3. If a system is offline, check network connectivity and status of the specific
system or application.
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Table 15. Problems with configuration of situations that you solve in the Manage Tivoli Enterprise Monitoring Services

window

Problem

Solution

After an attempt to restart the
agents in the Tivoli Enterprise
Portal, the agents are still not
running.

For UNIX, NetWare, or Windows, log on to the applicable system and perform
the appropriate queries.

The Tivoli Enterprise Monitoring
Server is not running.

Check the system status and check the appropriate IBM Tivoli Monitoring logs.

The managed objects you created
are firing on incorrect managed
systems.

Check the managed system distribution on both the situation and the managed
object settings sheets.

For agents that can have multiple s

ub-nodes, such as database agents:

The icon is incorrect.

Check the icon assignments in the template.

The situation is not assigned to a
state in the template.

Check the situation assignments in the template of the associated managed
object.

You assigned the situation to an

Check the State settings sheet for the template.

incorrect state in the template.

Sybase troubleshooting

lists problems that might occur on the system or application that you are monitoring. See the
IBM Tivoli Monitoring Troubleshooting Guide for general troubleshooting information.

Table 16. Sybase problems and solutions

Problem

Solution

(AIX® only) SQL text information is

available to the IBM Tivoli Monitoring.

The default Adaptive Server setting for max SQL text monitored is zero
(0). Do the following to change the setting to the recommended number
of bytes, 1024:

not

1. Run the following isql commands:
a. sp_configure "max SQL text monitored", 1024
b. go

2. Restart Sybase.

See the following Web document for more information:
http://manuals.sybase.com/onlinebooks/group-as/asgl1250e/monbook/
Gebt-1ink;pt=31387target=%25N%14_ 3401 START RESTART N%25

UTE-8 is not available.

Ensure that the UTF-8 character set is present and activated on the Sybase
server. For detailed information about configuration, see the Installation
and Configuration Guide for the Sybase agent.
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Chapter 4. Support information

If you have a problem with your IBM software, you want to resolve it quickly.

IBM provides the following ways for you to obtain the support you need:
Online
The following websites contain troubleshooting information:
+ Go to the [IBM Software Support website| (http:/ /www.ibm.com/support/entry/portal/
software) and follow the instructions.

* Go to the|Application Performance Management Wiki| (http:/ /www.ibm.com/developerworks/
servicemanagement/apm/index.html). Feel free to contribute to this wiki.

IBM Support Assistant
The IBM Support Assistant (ISA) is a free local software serviceability workbench that helps you
resolve questions and problems with IBM software products. The ISA provides quick access to
support-related information and serviceability tools for problem determination. To install the ISA
software, go to the IIBM Support Assistant Website| (http:/ /www.ibm.com/software/support/isa).
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Appendix. ITCAM for Applications documentation library

Various publications are relevant to the use of ITCAM for Applications.

For information about how to access and use the publications, see [Using the publications|
(http:/ /pic.dhe.ibm.com/infocenter/tivihelp /v61rl/topic/com.ibm.itm.doc_6.3/common/
using_publications.htm).

To find publications from the previous version of a product, click Previous versions under the name of
the product in the Contents pane.

Documentation for this product is in the [[TCAM for Applications Information Center|
(http:/ /publib.boulder.ibm.com/infocenter/tivihelp /v24r1/topic/com.ibm.itcama.doc_7.2.1/
welcome_apps721.html):

* Quick Start Guide
* Offering Guide

¢ Download instructions

* Links to Prerequisites

* Installation and Configuration Guide for each agent
* Link to Reference information for each agent

* Link to Troubleshooting Guide for each agent

Prerequisite publications

To use the information about the agents effectively, you must have some prerequisite knowledge.

See the following information at the [[BM Tivoli Monitoring Information Center] (http:/ /pic.dhe.ibm.com/
infocenter/tivihelp /v61rl/index.jsp) to gain prerequisite knowledge:

* IBM Tivoli Monitoring Administrator’'s Guide
* IBM Tivoli Monitoring Installation and Setup Guide
* IBM Tivoli Monitoring High Availability Guide for Distributed Systems

* IBM Tivoli Monitoring: Installation and Configuration Guides for the following agents: Operating
System agents and Warehouse agents

+ IBM Tivoli Monitoring: User's Guides for the following agents: Agentless OS monitors, Log file agent,
System p agents, Systems Director base agent

» IBM Tivoli Monitoring Agent Builder User’s Guide
* IBM Tivoli Monitoring Command Reference

* IBM Tivoli Monitoring: Messages

* IBM Tivoli Monitoring Troubleshooting Guide

+ IBM Tivoli Monitoring: References for the following agents: Operating System agents and Warehouse
agents

+ IBM Tivoli Monitoring: Troubleshooting Guides for the following agents: Operating System agents and
Warehouse agents

* Tivoli Enterprise Portal User’s Guide

Related publications

The publications in related information centers provide useful information.
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See the following information centers, which you can find by accessing [Tivoli Documentation Centrall
(https:/ /www.ibm.com/developerworks/community /wikis/home?lang=en#! /wiki/Tivoli
%20Documentation%?20Central):

* Tivoli Monitoring

* Tivoli Application Dependency Discovery Manager
* Tivoli Business Service Manager

* Tivoli Common Reporting

* Tivoli Enterprise Console

* Tivoli Netcool/OMNIbus

Tivoli Monitoring Community on Service Management Connect

Service Management Connect (SMC) is a repository of technical information that is organized by
communities.

Access Service Management Connect at [https:/ /www.ibm.com/developerworks/servicemanagement,

For information about Tivoli products, see the [Application Performance Management communityl|
(http:/ /www.ibm.com/developerworks/servicemanagement/apm/index.html).

Connect, learn, and share with Service Management professionals. Get access to developers and product
support technical experts who provide their perspectives and expertise. You can use SMC for these
purposes:

* Become involved with transparent development, an ongoing, open engagement between other users
and IBM developers of Tivoli products. You can access early designs, sprint demonstrations, product
roadmaps, and prerelease code.

* Connect one-on-one with the experts to collaborate and network about Tivoli and the Application
Performance Management community.

* Read blogs to benefit from the expertise and experience of others.
* Use wikis and forums to collaborate with the broader user community.

Other sources of documentation

You can obtain additional technical documentation about monitoring products from other sources.

See the following sources of technical documentation about monitoring products:

« [IBM Integrated Service Management Library] (http:/ /www.ibm.com/software/brandcatalog/
ismlibrary/) is an online catalog that contains integration documentation as well as other
downloadable product extensions.

« [IBM Redbook publications| (http:/ /www.redbooks.ibm.com/) include Redbooks® publications,
Redpapers, and Redbooks technotes that provide information about products from platform and
solution perspectives.

. (http:/ /www.ibm.com/support/entry/portal/software), which are found through the IBM
Software Support website, provide the latest information about known product limitations and
workarounds.

40 1TCAM Agent for Sybase ASE Troubleshooting Guide


https://www.ibm.com/developerworks/community/wikis/home?lang=en#!/wiki/Tivoli%20Documentation%20Central
https://www.ibm.com/developerworks/servicemanagement
http://www.ibm.com/developerworks/servicemanagement/apm/index.html
http://www.ibm.com/software/brandcatalog/ismlibrary/
http://www.redbooks.ibm.com/
http://www.ibm.com/support/entry/portal/software

Notices

This information was developed for products and services offered in the U.S.A. IBM may not offer the
products, services, or features discussed in this document in other countries. Consult your local IBM
representative for information on the products and services currently available in your area. Any
reference to an IBM product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product, program, or service that
does not infringe any IBM intellectual property right may be used instead. However, it is the user's
responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not give you any license to these patents. You can send
license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive

Armonk, NY 10504-1785 U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property
Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law
IBM Japan Ltd.

19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION “AS IS”
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE.

Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore,
this statement might not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of

the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation
274A/101

11400 Burnet Road
Austin, TX 78758 U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases
payment of a fee.

The licensed program described in this document and all licensed material available for it are provided
by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or
any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the
results obtained in other operating environments may vary significantly. Some measurements may have
been made on development-level systems and there is no guarantee that these measurements will be the
same on generally available systems. Furthermore, some measurement may have been estimated through
extrapolation. Actual results may vary. Users of this document should verify the applicable data for their
specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of
those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal without
notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject to change without
notice. Dealer prices may vary.

This information is for planning purposes only. The information herein is subject to change before the
products described become available.

This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to the names and addresses used by an
actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming
techniques on various operating platforms. You may copy, modify, and distribute these sample programs
in any form without payment to IBM, for the purposes of developing, using, marketing or distributing
application programs conforming to the application programming interface for the operating platform for
which the sample programs are written. These examples have not been thoroughly tested under all
conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these
programs. You may copy, modify, and distribute these sample programs in any form without payment to
IBM for the purposes of developing, using, marketing, or distributing application programs conforming
to IBM’s application programming interfaces.
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Each copy or any portion of these sample programs or any derivative work, must include a copyright
notice as follows:

© IBM 2009. Portions of this code are derived from IBM Corp. Sample Programs. © Copyright IBM Corp.
2009. All rights reserved.

If you are viewing this information in softcopy form, the photographs and color illustrations might not be
displayed.

Trademarks

IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of International Business
Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be
trademarks of IBM or other companies. A current list of IBM trademarks is available on the web at
[Copyright and trademark information| (www.ibm.com/ legal/copytrade.shtml).

«

Java
COMPATIBLE

Java™ and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or
its affiliates.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Microsoft and Windows are trademarks of Microsoft Corporation in the United States, other countries, or
both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Other company, product, or service names may be trademarks or service marks of others.

Privacy policy considerations

IBM Software products, including software as a service solutions, (“Software Offerings”) may use cookies
or other technologies to collect product usage information, to help improve the end user experience, to
tailor interactions with the end user or for other purposes. In many cases no personally identifiable
information is collected by the Software Offerings. Some of our Software Offerings can help enable you to
collect personally identifiable information. If this Software Offering uses cookies to collect personally
identifiable information, specific information about this offering’s use of cookies is set forth below.

Depending upon the configurations deployed, this Software Offering may use session cookies that collect
each user’s user name for purposes of session management, authentication, and single sign-on
configuration. These cookies cannot be disabled.

If the configurations deployed for this Software Offering provide you as customer the ability to collect
personally identifiable information from end users via cookies and other technologies, you should seek
your own legal advice about any laws applicable to such data collection, including any requirements for
notice and consent.

For more information about the use of various technologies, including cookies, for these purposes, See
IBM’s Privacy Policy at |http://www.ibm.com/privacy|and IBM’s Online Privacy Statement at
http:/ /www.ibm.com /privacy /details| the section entitled “Cookies, Web Beacons and Other
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Technologies” and the “IBM Software Products and Software-as-a-Service Privacy Statement” at
http:/ /www.ibm.com /software /info/product-privacy}
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